Linux auf Heimcomputern



I Organisatorisches

e Zeit: Do, 16h st — 17h Vortrag
I * Fragestunde am Ende
* Kein Schein
e Skripte & Ubungen unter
http://joerg-boesner.de/bildung/linux2003
» Ubungen
- Ubungsblatter austeilen

- Ubungen am Anfang der nichsten Stunde
besprechen



I Literatur

6. Auflage
e “Linux” von L
I Michael Kofler 1 n ux
Installation, Konfiguration,
* http://sdb.suse.de Arvendiig,
SuSE 8.2
* Internetsuche
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Erwartungen an Linux

e Unix ist die Zukunft — und das schon seit 30
Jahren.

* Unix sucht sich seine Freunde sorgfaltig
aus.

e Linux ist KEIN Uber-Windows, sondern ein
eigenes Betriebssystem mit Vor- und
Nachteilen!



I Vorteile von Linux

* Hervorragende Ressourcenausnutzung

* Vielseitiges Sicherheitskonzept

e Von “Natur aus” mehrbenutzertahig

* Netzwerkfahig

* Beliebig anpassbar (lduft sowohl auf 386er,
als auch P4)

* kostenlos

* frei

I * Stabilitat



I Welche Hardware lauft?

e Netzwerkkarten: keine Probleme

e USB-Tastatur/Maus: keine Probleme

* Sound: keine Probleme

e Scanner: siehe Internet

* Digitalkameras: siehe Internet

* TV-Karten: sofern Markenprodukt, kein
Problem

e [SDN: Keine Probleme, sofern
Markenprodukt

e Laptops: siehe Internet

I e Grafikkarten: keine Probleme



I Verwendetes System

* Desktop KDE 3.1.4
* Kernel 2.4.21
* OpenOiftice 1.1

I e SUSE Linux 9.0



I Bezugsquellen

- Die Boot-CD liegt im Verzeichnis /boot und
heilSst boot . 1s0, sie kann z.B. Mit Nero
gebrannt werden.

e preiswert als CD/DVD-Version im Handel
* Open Source => gratis + legal frei kopierbar
* Von Freunden/Bekannten kopieren

I * ftp-mirror des RZ-Wiirzburg (zur Zeit tot!)



Knoppix / SuSE Live Evaluation-
CD

* Linux zum “mal gefahrlos ausprobieren”

e Keine Installation, da direkt von CD
lauftdahig, aber Installation moglich

* SuSE bietet einen Vorgeschmack auf
kommende Distributionen



I Softwarevertrieb

- Paket (.rpm, .deb) oder als

- Sourcecode (.tar.Z, .tar.gz, .tar.bz2) vertrieben
* Yast verwendet rpm Pakete
* rpm = RedHat Packet Manager
* deb = Debian Format
* Sourcecode: eigentlich nur fiir Leute interessant, die
sich intensiver mit ihrem System beschéftigen
wollen.

* Die Pakete setzen sich z. T. gegenseitig
voraus, dies nennt man Abhédngigkeiten
(dependencies). Programme wie Yast
konnen diese rekursiv losen.

I e Software wird unter Linux entweder als



I Installation tiber FTP

 “Manual Installation” auswéahlen

* Sprache/Tastaturbelegung auswdhlen

* “Kernelmodule laden”

* “Netzwerktreiber laden”

* Geeignete Karte aussuchen (meistens
Realtek [8139to0])

I e Rechner von CD booten



I Installation tiber FTP

1St
 Nochmals Sprache wihlen

* Evtl. Treiberaktivierungen bestitigen
- Falls das System bei einem Treiber nicht
reagiert, beim ndchsten Installationsversuch
weglassen!

I * Warten bis Installationsprogramm geladen



Installation tiber FTP

“Installation / System starten”
“Netzwerk”
« FTP”

“Automatische Konfiguration via DHCP”
- Ja, falls Installation unten im Rechenzentrum

oder an einem DSL Router
- Nein, falls im CIP Pool oder DHCP fehlschlagt

Falls nein, IP Adresse,... beim Administrator
erfragen



Weitere Software hinzufiigen

* Auf den Hyperlink “Software” klicken

e Auf “Erweitert” klicken

* Nun kann weitere Software hinzugefiigt
werden, evtl. Auftretende Abhdngigkeiten
sollen gel6st werden!



I Gerate,... unter Linux

unter Linux in dem Verzeichnisbaum(der
genormt ist!) gespeichert.

* Gerdtedateien liegen im Verzeichnis
/dev

 Informationen tiber nahezu alles unter
/proc

* Konfigurationsdateien unter
/etc

I * Alle Gerate, Dateien, Informationen werden



I Benennung von Festplatten

I * IDE-Festplatten haben den Pritfix hd

* Danach folgt die Nummer der Platte:
- a = Primary Master
- b = Primary Slave
- ¢ = Secondary Master
- d = Secondary Slave

* Als Drittes folgt die Partitionsnummer.

* Die komplette Benennung der Festplatte ist
also: /dev/hdXy

e /dev/hdal steht also fiir die 1. Partition
auf der Bootfestplatte (Darauf ist
normalerweise Windows!)



I Ausgewahlte Software

Webbrowser (gibt's aut allen Platttormen!)

* kooka — sehr gutes Scanprogramm

e digikam - ftir Digitalkameras

* xawtv — einfaches, leistungsstarkes TV
Programm

e xmms -WinAmp fiir Linux (auch Plugins
installieren!)

* locate — wie im CIP Pool Dateien suchen

* usbview — zeigt alle angeschlossenen USB
Gerate an

I e Mozilla/Firebird — der wohl beste



Ausgewahlte Software

* GIMP - leistungstdhiges, aber extrem
gewOhnungsbediirftiges Grafikprogramm

* OpenOffice — Ahnlich wie MS-Office, aber
auf allen Plattformen verfiigbar und
kostenlos!

* LyX - Latexfrontend, damit lassen sich z.B.
Paper ohne Latex-Kenntnisse schreiben!



I Hilfe zu Installierter Software

man programmname

* Alternativ gibt es manchmal auch noch
info programmname

* Beide Programme lassen sich mit den
Pfeiltasten navigieren und mit “q”
beenden.

* Bei info kann man zuséatzlich mit einer Art
Hyperlink zwischen einzelnen Kapiteln

springen.

I * Hilfe zu fast jedem Programm gibt es mit



Grafik und Textkonsolen

* Da Linux ein Mehrbenutzersystem ist,
konnen sich auch mehrere Benutzer
einloggen. Datfiir gibt es verschiedene
Konsolen, zwischen diesen kann man mit
[Alt]+[Fn] umschalten. Um von den
Grafikkonsolen (F7 aufwarts) umzuschalten
muss man [Strg]+[Alt]+[Fn] driicken.

* KDE unterstiitzt mehrere Desktops, man
kann diese mit [Strg]+[Tab] durchbléttern
und mit [Strg]+[Fn] direkt anwadhlen.



I Arbeiten an der Konsole

als man denkt, obwohl Unices zwischen
Grol$- und Kleinschreibung unterscheiden.
* Dateinamen konnen mit der Tabulatortaste
ergdnzt werden, falls es (noch) nicht
eindeutig ist.
* Wildcards konnen fast analog zu DOS
eingesetzt werden.

I e Das Arbeiten an der Konsole ist einfacher



Kompatibilitiat zu M$

* OpenOffice kann die meisten Microsoft-
Formate importieren, da allerdings die MS-
Office-Formate nicht offen gelegt sind,
konnen Verluste bei der Formatierung
auftreten. Das ist eine Einschrankung, die
MS kiinstlich gemacht hat und keine
Einschrankung von Linux / OpenOffice!

* Deshalb: Auch unter Windows Programme
verwenden, die offengelegte Formate
(OpenOiftice, aber auch RTF) unterstiitzen!



I Einbinden von Partitionen

* Bevor Linux auf Partitionen / CDs /

I Netzwerklautwerke zugreiten kann miissen
sie eingebunden (gemountet) werden.

* Aus Sicherheitsgriinden kann das
normalerweise nur “root”, die meisten
Distributionen sind so eingerichtet, dass
jeder auf die Standardgerite, die bei der
Installation vorhanden waren, zugreiten
kann.



Manuelles Mounten

* Um ein Dateisystem einzubinden, das
nichtin /etc/fstab steht, muss man sich
als “root” anmelden und
mount /dev/gerat /media/gerat
ausfiihren.

/media/gerat muss ein existierendes
Verzeichnis sein!

 Falls das Dateisystem nicht erkannt wird,
den Typ mit -t Typ angeben!

e Musik-CDs, Video-CDs und DVDs miissen
nicht gemountet werden!



I [etc/fstab

* In dieser Datei stehen alle Informationen
I tiber haufig gebrauchte Dateisysteme. Die

Datei hat folgendes Format:
/dev/gerat /mountpunkt Typ Optionen 0 O

* Die erste Spalte gibt den vollstandigen (!)
Pfad zum Gerat an, die zweite ein
existierendes Verzeichnis, die dritte den
Dateisystemtyp (im Zweifelsfall “autofs™), in
der vierten stehen Zusatzoptionen, die
Nullen am Ende stehen lassen!



I Wichtige Dateisysteme
* autofs: Probiert alle Systeme der Reihe
I durch
* ext2/ext3: Die “Standard”-Linux-
Dateisysteme

* reiserfs: Mein personlicher Favorit
* smbfs: Die Windowsireigaben, das Gerat ist

dann //Windowsrechner/Freigabe
- als Befehl kann dann smbmount verwendet
werden.

* 1s09660: Das Standard-CD-Format



Windowsireigaben

* Am sinnvollsten ist es, die Berechtigungen
aut Freigabeebene zu setzen, da Windows
keine sinnvolle Benutzerverwaltung hat.

* neuere Windowssysteme verwenden
verschliisselte Passworter, diese miissen
unter Linux explizit mit smbpasswd
festgelegt werden.

* Meistens verlangen deutsche
Windowsversionen trotzdem den
Benutzernamen “Gast”, englische “guest”.



Freigaben browsen

* Mit KDE lassen sich bequem Freigaben
browsen, allerdings sind diese dann nur fiir
KDE Programme zuganglich!

* Dazu muss ein so genannter Damon lauten,
dieser ist bei SUSE standardmalSig NICHT
aktiviert.

* Der Damon befindet sich im Paket
kdenetwork3-1isa, dieses muss gegeben
falls mit allen Abhdngigkeiten installiert
werden.



Damonen starten

* Damonen konnen grundsatzlich nur als
root gestartet werden.

 Dazu kann man in Yast unter System ->
Runleveleditor -> Expertenmodus die
Dienste aktivieren.

e Um einen Dienst dauerhaft zu aktivieren,
trdgt man ihn im Runlevel 5 ein (bei Lisa
empiehlenswert).



Runlevel

* Unices verwenden Runlevel, ein Konzept,
das unter Windows vollig unbekannt ist.
 Runlevel werden mit init <runlevel>
gedndert (z.B. wechselt init Sin den

Einzelbenutzermodus)

* In jedem Runlevel konnen - vollig
unabhéngig — verschiedene Dienste und
Treiber aktiviert sein, so dass es ohne
Probleme moglich ist, einen Desktop in
einen Server zu verwandeln, ohne in die
Konfiguration eingreifen zu miissen.



I Windowstreigaben mounten

e Um auch als normaler Benutzer Windows-
I freigaben mounten zu konnen, muss

/usr/local/bin/smbmnt als root laufen,
um dieses zu erreichen muss das suid - Bit
der Datei gesetzt sein. Das erreicht man als
root mit chmod 4755 \
/usr/local/bin/smbmnt

 Der Backslash steht dafiir, dass die Zeile
fortgesetzt wird.

* Das Verzeichnis, in das gemountet wird,
muss dem Benutzer gehoren!



I Gerate unmounten

wird, muss es geunmountet werden, dabei
darf kein Prozess mehr die Datei verwenden!

e Um festzustellen, welcher Prozess einen
Mountpoint blockiert, kann man
fuser -mv /Mountpoint verwenden.

* fuser -mvk /Mountpoint totet diese Prozesse
dann, dabei ist aber Vorsicht geboten!

e Das Gerat wird mit umount /Mountpunkt
wieder entfernt.

I e Bevor ein Gerat aus dem Rechner entfernt



I Multimedia

* Linux hat hervorragende Multimedia-

I fahigkeiten, allerdings sind aus rechtlichen
Griinden (Microsoft & Co. verhindern die
Auslieterung ihrer Codecs mit Linux) die
mit allen Distributionen mitgelieferten
Videoplayer so stark abgespeckt, dass eine
verniinftige Nutzung unmaoglich ist.

* Esldsst sich aber relativ einfach ein eigener
Videoplayer compilieren.



I Audio unter Linux

* Autf die Soundkarte kann unter Linux
I standardmalSig nur ein Prozess zugreiten.

* Um diese Einschrankung zu umgehen, lauft
unter KDE ein so genannter Soundserver
(arts), das entsprechende Programm heilst
artsd.

 KDE Programme verwenden artsd als
Standardausgabe, Programme wie XMMS
miissen von Hand auf artsd umgestellt

werden.



Wichtige Befehle

alias: Kann Kurzbefehle definieren
apropos: Stichwortsuche in man-Texten
bg: setzt mit Ctrl-Z unterbrochene Prozesse
im Hintergrund fort

cat: Unix-Analogon zu MS-DOS type

cd: analog zu DOS

chgrp: dndert Gruppe, siehe weiter hinten
chmod: andert Dateiattribute, “

chown: dndert Benutzer+Gruppe, “

cp: kopiert Dateien — siehe man-Page!

dd: kopieren und konvertieren



I Wichtige Befehle

* dmesg: Kernelmeldungen, auch bei Start!

* du: Zeigt Platzverbrauch von Dateien und
Verzeichnissen an

 fdisk: Partitioniert Festplatten

* fg: wie bg, setzt aber Programm im
Vordergrund fort.

e file: rat den Dateiinhalt

* find: sucht Dateien

* free: zeigt freien Arbeitsspeicher an

e grep: sucht Zeichenketten

I e df: Wieviel Speicherplatz ist noch frei?



Wichtige Befehle

. groupadd groupdel: fiigt Benutzergruppen

hinzu oder 16scht sie

* halt: stoppt den Rechner

* head,tail: die ersten/letzten Zeilen einer
Datel anzeigen

e kill: totet Prozesse

e killall: totet alle Prozesse mit gleichem
Namen

* 1dd: zeigt Bibliotheksinformationen an

* ]less: zum Lesen von ASCII-Dateien




I Wichtige Befehle

* In; erstellt Links auf Dateien
I * lpr: Druckt Dateien aus der
Kommandozeile
e ]Jocate: sucht Dateien in einer Datenbank
* 1s,lLl: zeigt Dateien an
°* man: man-Pages
e mkdir: erstellt Verzeichnisse
* mv: verschiebt Dateien (Achtung mit
Wildcards!!)
* newgrp: Andert die primére Gruppe eines
Benutzers



I Wichtige Befehle

Prioritat ablaufen.
nohup: startet untdtbare Prozesse

e passwd: dndert das Passwort

* ps: zeigt laufende Prozesse an.

* pstree: ebenso, aber als Baumstruktur

* reboot: Wer sich wieder nach Windows
sehnt....

* renice: nice im nachhinein

* reset: Stellt Zeichensatz wieder her,
rebootet das System nicht!

I * nice: Lasst Programme mit niedriger
[



Wichtige Befehle

rm: loscht Dateien, rm -r macht tabula rasa!
rmdir: loscht Verzeichnisse

rpm: installiert Pakete von Hand nach
sort: sortiert Daten

su: dndert den Benutzer

tar: Packt und entpackt Dateien:

tar -xjvi Datei entpackt .tar.bz2 Dateien
tar -xzvt Datei entpackt .tar.gz und .tgz
Dateien

top: Zeigt Prozessorauslastung und mehr
an.



Wichtige Befehle

mount/umount: bindet Gerate ein
updatedb: aktualisiert die locate-
Datenbank

useradd: fiigt Benutzer hinzu
userdel: 10scht Benutzer

which: zeigt an, welches Kommando
ausgeflihrt wiirde

who: zeigt eingeloggte Benutzer an



Dateirechte unter Unix

e Unices verwenden ein standardisiertes

Rechtesystem, das “Eigentiimer”,
“Gruppe”, “Andere” bestimmte Rechte
zuweisen, eine explizite Zuweisung an
einzelne Benutzer wie unter Windows N'T
ist nicht maoglich!

Seine Gruppenzugehorigkeit kann man mit
groups erfahren, seine primédre Gruppe
mit newgrp dndern.

Seinen eigenen Loginnamen kann man mit

whoami erfahren.



I Interna

* Der Dateibesitzer und die Gruppe werden
I unter Unices nicht als Klartext wie bei

Windows, sondern als so genannte User
und Group IDs abgespeichert, dies hat den
Vorteil, dass sich Benutzer leicht
umbenennen lassen.

* Root hat die User-1ID 0.

* Systemdienst haben User-IDs 0<500

* Normale Benutzer haben User-IDs > 500



Dateirechte im Einzelnen

* Jeder dieser Gruppen kann man die Rechte
“read”, "write”, “execute” geben, bei
Dateien sind die Rechte selbsterklarend, bei
Verzeichnissen steht “execute” fiir das
Recht, in das Verzeichnis zu wechseln.

* Die Dateirechte konnen mit chmod gesetzt
werden.

e Der Eigentiimer kann mit chown gesetzt

werden.



Spezialbits

* Aulser den Zugriftsrechten gibt es noch
Spezialbits:

e SUID: Das Programm lduft nicht unter der
User-ID des Starters, sondern unter der
User-ID des Programms (meist root), dies
kann ein Sicherheitsrisiko darstellen!

* GUID: Analog mit der Gruppe

* Sticky: In einem Verzeichnis kann nur der
Besitzer einer Datei diese l0schen, nicht
alle anderen, die in diesem Verzeichnis
Schreibrechte haben.



I chown

Gruppe, der Aufruf lautet:
chown Benutzer|[:Gruppe] Datel

* die in eckigen Klammern stehende Teile
konnen weggelassen werden (dies
entspricht auch der Konvention, die in den
man/info-Pages verwendet wird).

* Man kann als Benutzer keinem anderen
Benutzer eine Datei zuweisen, ebenso
keine Gruppe, der man nicht selber
angehort.

I e chown setzt den Benutzer und evtl. die



I chgrp

e Mit chgrp kann man entsprechend die
I Gruppenzugehorigkeit einer Datei dndern,
hier gelten die selben Einschrankungen wie
bei chown.



I chmod

* chmod setzt die Zugritfs- und Spezialbits
I fiir Dateien und Verzeichnisse.
e Dabei sind zwei verschiedene Modi
moglich:
 Im Oktalmodus werden alle Bits auf einmal
gesetzt
e Im “bildlichen” Modus konnen die
einzelnen Bits durch Symbole gesetzt
werden.



I Oktaler Modus

* Die Bits werden direkt in Zahlen gesetzt:

Das hochstwertige Bit pro Zitfer ist
I “read” (suid), das mittlere “write” (sgid), das

niederwertigste “execute” (sticky), somit
steht
chmod 4750 Datex
fiir;: Benutzer dart, lesen, schreiben und
austiithren, Mitglieder der Gruppe diirten
lesen und ausfiihren(mit suid), alle anderen
dirfen gar nichts.

* Fihrende Ziffern diirfen weggelassen
werden.



I “Bildlicher” Modus

* Hier konnen die einzelnen Bits mit
I Symbolen gesetzt werden:

e Dazu wird hinter chmod ein Buchstabe
angegeben, der entsprechend fiir user,
group, others, all steht, danach folgt jeweils
ein + fiir Setzen oder ein — fiir Loschen,
danach folgt der Kurzbuchstabe des zu
setzenden Bits:
read, write, execute, sticky, set-id



I chmod Beispiel

e chmod g+rwxs Dateil
I erlaubt es Leuten, die in der gleichen
Gruppe sind, die Datei zu lesen, schreiben
und auszufiihren und , alle anderen
Attribute bleiben unverandert.



Switches fiir chmod und chown

 Sowohl chmod und chown akzeptieren den
Switch -R, dieser besagt, dass die
Anderungen auf alle Unterverzeichnisse
und die darin enthaltenen Dateien
angewendet werden.

e Dies unterscheidet sich von rm, bei dem
der Switch - r heilst!



I Videoplayer installieren

sinnvoller Videoplayer am besten selbst
beschafft und compiliert werden.

* Der zur Zeit beste Player ist wohl mplayer.

* Er kann unter http://www.mplayerhq.hu
heruntergeladen werden.

* Zur Verwendung unter KDE sollte das
artsd-Entwicklerpaket (arts-devel)
installiert werden.

I e Wie schon vorher erwdahnt, muss ein



I mplayer

I e Die Installation ist unter /DOCS/German/ *

erklart.
e Zu shared libraries siehe Vorlesung!



I Filesystem Hierarchy Standard

Verzeichnisbaum, hier wird nur grob auf

I e Linux verwendet einen standardisierten
die wichtigsten Verzeichnisse eingegangen!



FHS

/bin: elementare Programme fiir alle
/boot: Dateien zum Booten des Systems
/dev: Geratedateien: Finger weg!

/etc: systemweite Konfigurationsdateien
/home: alle Homeverzeichnisse, auf die die
einzelnen Benutzer Zugritf haben

/lib: enthdlt die shared libraries, unbedingt
in Ruhe lassen!

/mnt, /media: Mountpunkte fiir Gerite
[opt: zusdtzliche Programme



FHS

* /proc: Alles mogliche zu Prozessen,...

e /root: Das Homeverzeichnis von root

e /sbin: Befehle fiir root

* /tmp: tempordres Verzeichnis

e /usr: Unix shared resources: Nahezu das

ganze System
— /usr/local: Die meisten Programmpakete
— [usr/src: Quelltexte von Programmen

e /var: Loggingdatein, Mails,...
e /windows: Mountpunkte fiir
Windowspartitionen



Scanner unter Linux

* Das wohl beste Scanprogramm ist kooka, es
kann unter Yast nachinstalliert werden.

* Esfindet sich im Startmenti unter
Multimedia oder mit [Alt][F2] und “kooka”

* Das Interface ist fiir alle Scannertypen
gleich, ein Scannerwechsel ist also ohne
Probleme maoglich!



Installation mit Yast

Scanner konnen einfach unter Yast
installiert werden, dazu einfach den
entsprechenden Punkt unter “Hardware”
wahlen.

Noch fehlende Pakete nachinstallieren
Den Scanner aus der Liste wahlen.

Falls nur ein dhnlicher Scanner vorhanden
ist, ist dies KEINE Funktionsgarantie!



I Scannen

* Kooka ist selbsterklarend, allerdings sind
I die gescannten Bilder etwas versteckt:

e ~/.kde/share/apps/ScanImages

e Am besten mit 1s -s einen Softlink ins
Homeverzeichnis setzen.

* Wer unbedingt gimp verwenden will, kann
mit Xtns->Aquire Image den Scanner
auswahlen und das Bild scannen.



USB Massenspeicher

* USB Massenspeicher wie Festplatten, USB-
Sticks oder bestimmte Digitalkameras
konnen unter Linux als SCSI-Festplatte
angesprochen werden.

* Am besten beim Einstopseln die
Meldungen aut Konsole 10 ([Ctrl]+[Alt]+
[F10]) beobachten, dort erscheint dann eine
Information, als welche Platte das Gerat
angesprochen werden kann.



I Digitalkameras

unterstiitzt wird!

* Das Photoprogramm mit “digikam” starten

* Unter Setup->FEinstellungen->Kamera-
einstellungen die Automatische Erkennung
austiihren.

* danach kann die Kamera im
“Kamera”-Ment angesprochen werden.

* Am einfachsten ist die Datentibertragung
per Drag&Drop in ein Album.

I e Bitte vorher sicherstellen, dass die Kamera



I Modems und Internet

* Modems koénnen unter Yast mit dem
I entsprechenden Meniipunkt unter der

Registerkarte “Netzwerkgerite”
eingerichtet werden.

* Die Erkennung funktioniert bei externen
Modems meist problemlos.

* Modems in Laptops sind keine echten
Modems und funktionieren selten!

* Provider konnen ebenfalls einfach
hinzugefiigt werden



ISDN

* SuSE unterstiitzt nahezu alle Marken-ISDN
Gerate.

* Die Einrichtung erfolgt analog zu Modems
ebenfalls unter “Netzwerkgerdte”.

* Die meisten Einstellungen kbnnen ohne
Anderung tibernommen werden, lediglich
ein Provider muss gewdhlt werden, die
Zugangsdaten liefert der Provider.

* AOL funktioniert nicht unter Linux!



Der X-Server

* Der X-Server ist das Programm, das
tatsachlich die Gratik anzeigt.

e Auf den X-Server konnen mehrere Clients
(verschiedene Benutzer, auch von
verschiedenen Rechnern) zugreifen.

* Damit nicht jeder auf einfach ein Fenster
auf einer beliebigen Arbeitsflache 6ifnen
kann, besitzt der X-Server Autentifika-
tionsmechanismen.



Benutzer autorisieren

* Am einfachsten an einem Privatrechner ist
es, einfach jedem den Zugrift auf den X-
Server zu gewdhren.

* Dazu gibt man als der Benutzer, der den X-
Server gestartet hat, xhost + ein.

* Um den Zugriff wieder zu verhinder, gibt
man entsprechend xhost - ein.



I X-Server wahlen

Server sie verwenden sollen, muss eine so
genannte Variable gesetzt werden, diese
Variable heilSt DISPLAY.

 Unter der bash (die Standardshell unter
Linux) geschieht das mit export.

 Der Betehl heil$t dann:

export DISPLAY=Rechner:Displaynummer
e Fiir den lokalen Rechner also:
export DISPLAY=1localhost:O0

I * Damit X-Programme wissen, welchen X-



Als root Programme unter X
ausfiihren

Konsole offnen (z.B. konsole)
xhost + eingeben.

su -1 eingeben.

Passwort eingeben.

export DISPLAY=localhost:0 eingeben.
Das Programm als root austiihren.

mit 1logout wieder zum Benutzer
zurtickgehren.

mit xhost - den Server wieder sperren.
Sich nicht unter KDE als root anmelden!



I Schriften unter X

e Falls man unter X neue Schriften (z.B. die
I Windows-Systemschriften oder von einer

Shareware-CD), kann man dies am
einfachsten unter dem KDE-
Kontrollzentrum unter dem Punkt
Systemverwaltung->Schriften-Installation
tun.

* Solang man nicht in den Systemver-
waltermodus wechselt, sind die

Anderungen nur fiir den aktuellen Benutzer
giiltig.



OpenOffice

* OpenOffice ist ein exzellentes
Officeprogramm, das in vielen Dingen MS-
Office gleichwertig ist und auch MS-Office-
Dokumente nahezu ohne Verlust
importieren kann.

* OpenOiffice kann an der Kommandozeile
durch sof fice gestartet werden

* Das Programm ist mehr oder weniger
selbsterklarend in der Bedienung und hat
eine gute Hilfe.



I Schriften unter OO

e Schriften konnen/missen unter OO
I getrennt vom X-Server installiert werden.

* Dies kann — wie unter Unix tiblich — nur der
Administrator global tun.

* Dazu wechselt man wie vorher zu root und
startet das Setup-Programm fiir Drucker
und Schriften(man mul$ Zugriff auf den X-
Server haben!):

e /opt/OpenOffice.orgl.l.0/spadmin

e Jetzt lassen sich einfach neue Drucker und
Schriften hinzutiigen.



I
I o

* Lyx ist ein Frontend zu Latex (Latex wird
I sehr haufig als einziges Format bei
wissenschaftlichen Veroffentlichungen
akzeptiert), mit dem sich sehr schnell
hervorragend gesetzte Dokumente erstellen
lassen.
e Lyx wird durch den Aufruf 1yx gestartet.



I Dokumente erstellen

werden.

e Allerdings muss man beachten, dass Lyx
das Dokument NICHT so anzeigt, wie es
nachher gesetzt wird! Es werden nur
Informationen tiber das Dokument
gesamimelt, der eigentliche Satz geschieht
extra!

I * Dokumente konnen wie gewohnt erstellt



Wichtiges zur Verwendung

* Ein millimetergenaues Layout ist mit Lyx
nicht moglich (daftir kann man sich voll auf
den Inhalt konzentrieren!), dafiir ist Latex
auch gar nicht gedacht.

e Eine Vorschau des Dokumentes kann mit
[Ctrl]+[T] betrachtet werden, dazu mul$
Latex installiert sein!



I Dokumentvorlage auswahlen

die gesamten Einstellungen wie
Papierformat, Dokumentenklasse (die alle
Formate enthdlt!) &ndern.

* Falls man bei fertig geschriebenem
Dokument einen allzu groffen Wechsel in
der Dokumentenklasse durchfiihrt (z.B. von
,b00k" nach , hollywood®) kann es sein,
dass Lyx abstiirzt!

I e Mit Klick auf Layout->Document kbnnen



Mathematische Formeln

* Besonders gut geht mit Lyx der Formelsatz.

* mit [Alt]+[M],[M] gelangt man in den
Formelmodus (durch rote Klammern
gekennzeichnet).

* Nun konnen mit Insert->Math->Math
Panel die verriicktesten Zeichen
eingegeben werden.

e Hochzahlen konnen mit ~ ,Indices mit _
eingefiigt werden (falls der Cursor nicht
gleich in die jeweilige Ebene springt, mit
der Leertaste bestdtigen)



Mathematische Formeln

* Die jeweilige Eingabeebene kann mit der
Leertaste verlassen werden, falls man in
einer Formel ein Leerzeichen benotigt,
kann es mit [Ctrl]+[Leertaste] eingegeben

werden.

* Bei jeder Eingabe steht das zugehorige

Tastaturkommand
Math Panel steht ¢

0 in der Statusleiste. Im
er zugehorige Code

dahinter (z.B. \alp!

na = o)



I CDs brennen

* K3B ist das wohl beste Brennprogramm
I unter Linux. Es brennt die CDs nicht selber,
sondern tiberldsst diese Aufgabe speziellen
Kommandozeilentools wie cdrecord,
mkisofs und cdrdao.

e Um K3B zu verwenden, muss es erst
eingerichtet werden, dazu startet man das
Programm k3bsetup. Dieses benotigt das
Root-Passwort, weil einige
Systemeinstellungen gedandert werden
mussen.



K3B einrichten

* k3bsetup befindet unter Einstellungen ->
Einrichtungsassistent

* Als erstes muss eine Gruppe gewahlt
werden, die Zugriftf auch den CD Brenner
hat, falls es alle sein sollen, erscheint
“users” geeignet.

* Die restlichen Einstellungen konnen
libernommen werden.



I K3B bedienen
e K3B lasst sich sehr intuitiv bedienen:

I * Einfach unten rechts die gewtinschte
Aktion auswihlen oder unter Datei ->
neues Projekt -> ....... ein neues Projekt
erstellen.

e Danach lassen sich einfach Dateien aus
dem oberen Fenster unten auf die CD
schieben.

* Die Dateien konnen dann wie gewohnt mit
dem Kontextment (rechte Maustaste)
umbenannt,geldscht,... werden.



I CDs brennen

e Um die CD nachher zu brennen, einfach
I unten auf den ,Brennen“-Knopf driicken.

* Nun konnen weitere Optionen ausgewdhlt
werden, die meisten Optionen sind sinnvoll
gewdhlt, allerdings sollte unter
,Dateisystem” noch zusitzlich ,]Joliet"
aktiviert werden, damit die CDs auch unter
Windows lesbar sind.

* Die Brenngeschwindigkeit wird
automatisch an den Rohling angepasst.



I MP3s und Ogg Vorbis

* K3B kann auch MP3s und andere
I Sounddateien direkt als Audio-CD

brennen, allerdings ist die MP3-
Unterstiitzung bei SuSE standardmalsig
deaktiviert, es gibt allerding eine einfache
Losung, die im Internet-Teil steht.

* Beim Brennen von Musik ist unbedingt das
Copyright zu beachten!



I Video-CDs brennen

Formate brennen.

* eMovix: Kann fast jedes Format abspielen,
wenn direkt von der CD gebootet wird.

* Video-CD: erstellt Video-CDs fiir den DVD-
Player.

* Auch hier gilt: Das Copyright beachten!

I e K3B kann auch die verschiedensten Video-



I Multimedia

* Um MP3s abzuspielen gibt es zwei Player:

I * xmms, der Standardplayer unter Unices, er
orientiert sich an WinAmp 2© und ist
selbsterklarend, unter KDE sollte die
Soundausgabe unter Rechtsclick -> Options
-> Preferences -> Audio I/0O Plugins ->
Output-Plugin auf arts umgestellt werden,
sonst scheint der Player zu ,,hangen®.



Multimedia

* noatun: Dieses ist ein KDE-Medienplayer
und sehr gut in den Desktop integriert, so
kann der Player z.B. mit einen Klick auf das
Icon im Systemabschnitt der Kontrolleiste
maximiert und minimiert werden und
durch Tastenkiirzel gesteuert werden.

e Zusdtzliche Plugins konnen unter
Einstellungen -> noatun einrichten ->
Plugins installiert werden, bei Klick aut
<2Anwenden“ werden links zusdtzliche
Schaltflachen dafiir sichtbar.



I CDs wiedergeben

* kscd ist ein gut in KDE integriertes CD-

I Wiedergabeprogramm, das sich durch Klick
auf das Symbol in der Taskleiste
minimieren lasst.

* kscd kann auch die Namen der CD mit
einer Datenbank im Internet (freedb.org)
abgleichen und so eine einfache Auswahl
der Stiicke auf der CD ermoglichen, dazu ist
eine Internetverbindung erforderlich.

e Die Einstellungen finden sich unter dem
Symbol mit Hammer und Meil3el.



Instant Messenger

* licq: Der wohl beste ICQ Client unter Linux,

unter KDE am besten mit

kstart --tosystray --window \
LicgWharf licqg

starten, damit auch das Icon (Options ->
General -> Docking) im Systemabschnitt
richtig dargestellt wird und unter Menii ->
Options -> OnEvent artsplay unter
Command eingeben, damit der Sound
unter arts richtig wiedergegeben wird.



I Allgemeines zu ICQ

Firma Mirabilis, Mirabilis unterstiitzt kein
Linux und hat auch die Spezifikationen des
Protokolls nicht freigegeben, so dass die
Linuxcommunity auf Reverse-Engineering
angewiesen ist. Daher funktionieren
manche Dinge nicht oder nicht richtig.

* Mirabilis ist auch jeder Zeit in der Lage, den
Dienst fiir Linuxbenutzer zu sperren, so
dass kein Zugritf mehr auf ICQ moglich ist.

* Jabber ist dagegen ein freier Dienst.

I e ICQ ist ein kommerzielles Produkt der



I Kopete

* Kopete unterstiitzt verschiedene Instant
I Messeger Protokolle:

* Aol Instant Messenger, ICQ, IRC, Jabber,
Microsoft Messenger, SMS, Windows-
Nachrichtendienst und den Yahoo
Messenger.

* Die ICQ-Unterstiitzung ist bei licq besser!

* Kopete kann iiber kopete gestartet werden
und ist vollstandig in KDE integriert.



Konten einrichten

* Unter Einstellungen -> Kopete einrichten
-> Konten kann ein neues Konto
hinzugefiigt werden.

e Fiir Leute, die zum ersten Mal einen Instant
Messenger verwenden empftehle ich Jabber
(siehe auch http://www.jabber.org), da es
dort exzellente Clients fiir alle
Betriebssysteme gibt.

* Ich bin unter joerch@jabber.org erreichbar,
selten unter ICQ #140068026.



I Chat
I a

* kvirc (sehr grof8er Funktionsumfang!)

 ksirc (klein und kompakt)

* Der Aufruf erfolgt jeweils mit dem
Programmnamen

* Der Chatzilla hat Probleme mit Umlauten.

* Das Chatmodul bei kopete ist meiner
Meinung nach nicht so gut gelungen(aber
das wird sich bestimmt dndern)!

* Alle IM lassen sich durch Klick aut das Icon
im Systemabschnitt aus- und einblenden.

I * Gute Chatprogramme unter KDE sind:



I Spiele

* Frozen-Bubble, Start mit artsdsp
frozen-bubble

e Space Duel: Start mit kspaceduel

e Tetris: Start mit ksirtet

e Minigolf: Start mit kolf

* Weiter Spiele finden sich unter dem K-
Menu -> Spiele

e Falls ein (Nicht-KDE) Spiel beim Start
hangt, oder kein Sound kommt, mit
artsdsp Spilielname starten.

I e Hier ein paar nette Spielchen:



I Mozilla

Version des Webbrowsers Mozilla aus.
 Die neueste (deutsche) Version kann von
http://mozilla.kairo.at heruntergeladen
werden.
* Die Version ohne Installationprogramm ist
am einfachsten zu inteallieren!

I e SUuSE liefert momentan nicht die neueste



I Mozilla installieren

Verzeichnis kopieren, in dem Mozilla
intealliert werden soll, z.B.:
mv /home/joerg/mozilla-1.5.tar.gz \
/opt
e In dieses Verzeichnis wechseln:
cd /opt
Die Datei entpacken:
tar -xzvf mozilla-1.5.tar.gz

* Die Datei kann nun geldscht werden:
rm mozililla-1.5.tar.gz

I * Die heruntergeladene Datei als root (!) in das



I Plugins installieren

Plugins installiert werden:
* Realplayer
* Flashplayer
* Java
* Acrobat Reader

I e ITn Mozilla konnen die verschiedensten



I Acrobat Reader

mitgelietert und standardmalSig installiert,
allerdings mul$ das Plugin tiir Mozilla
manuell installiert werden, dazu muld es
einfach in das Pluginverzeichnis kopiert
werden:

e cp /usr/X11R6/lib/Acrobat5/Browsers/\
intellinux/nppdf.so /opt/mozilla/plugins

* Beim ndchsten Start von Mozilla ist das
Plugin aktiv.

I e Der Acrobat Reader wird mit SuSE



I Real Player

* Der Realplayer fiir Linux kann unter der im

I Internetskript angegebenen Adresse
heruntergeladen werden, benotig wird er
Fir Linux 2.x (libc6 1386) fiir Pentium.

e Zur Installation wechselt man zu root.

* Das Installationsprogramm mul$ erst
ausfiihrbar gemacht werden, da unter Unix
neu erstellte Dateien nicht ausfiihrbar sind:
chmod 755 rp8._....bin

* Danach kann das Installationsprogramm
mit ./rp8_....bin gestartet werden.



Realplayer starten

* Nach dem Emailadresse,... eingetragen sind,
startet der Realplayer nach der Installation
(noch als root!), er sollte wieder beendet
werden!

* Realplayer ist kein KDE-Programm und muss

daher mit artsdsp gestartet werden:
artsdsp /usr/local/RealPlayer8/realplay

* Da auch mplayer den Real-Codec verwenden
kann, ist er meist die bessere Wahl!



I Realplayer Plugin

einfach nur in das Plugin-Verzeichnis
kopiert werden:

Cp /usr/local/RealPlayer8/rpnp.so \
/opt/mozilla/plugin/

* Da das Realplayerplugin nicht mit arts
kompatibel ist und Mozilla nicht mit
artsdsp funktioniert, muld vor der
Verwendung arts mitkillall artsd
beendet werden.

I * Das Plugin fiir Mozilla mul$ ebentalls



I Java

funktioniert nicht mit Mozilla!

* Eine gute Javaengine kann unter
ftp://ttp.gwdg.de/pub/languages/java/linu
x/JDK-1.3.1/1386/FCS heruntergeladen
werden, sie funktioniert aber soviel ich
weils nur unter der englischen
Originalversion von Mozilla.

* Die Javaengine kann wie Mozilla installiert
werden, indem sie einfach entpackt wird.

I * Das Javaplugin, das von Sun erhaltlich ist,



I Pfad fiir Java setzen

* Damit die neu installierte Java-Version
I auch getunden wird, muss sie in den Pfas
eingetragen werden, dazu muss als root
echo 'export \
PATH=/opt/j2rel.3.1/bin:$PATH' >> \
/etc/protile.local ausgefiihrt und alle
Benutzer ab- und wieder angemeldet

werden.



Flashplayer installieren

Der Flashplayer ldasst sich am einfachsten
tiber http://plugins.netscape.com finden,
er liegt ebenfalls als Archiv vor und kann
wie Mozilla entpackt werden.

Das Archiv enthdlt zwar ein
Installationsprogramm, das aber zu
umstandlich ist.

Einfach die im Archiv enthaltenen Dateien

in das Pluginverzeichnis kopieren:
cp /flashplayer/* /opt/mozilla/plugins



Die Kommandozeile

* Bei fast allen Linuxdistributionen wird als
Kommandointerpreter bash installiert.

* bash nimmt die Kommandos dhnlich wie
frither unter MS-DOS entgegen, kann aber
weit mehr!

* bash steht tibrigens fiir ,bourne again
shell®, ein Wortspiel, da die bash ein
Nachtolger der klassischen bourne shell ist.



Andere Shells

* Andere Shells konnen jederzeit durch
Eingabe des Namens aufgerufen werden,
indem der Name der Shell eingegeben wird
(z.B. csh). Die Shell kann wieder mit exit
bzw. [Ctrl]+[D] verlassen werden.

* Den Namen der aktuellen Shell kann man
mit echo $0 erfahren, bei meiner csh
erscheint ein Korrekturvorschlag, dieser
kann ignoriert werden.



I Login Shell

bash beim Login verwenden will, kann man
diese mit chsh /bin/Shellname dndern.

 Falls eine Fehlermeldung wie ,,unknown
user” erscheint, ist das Programm
interaktiv und akzeptiert als Parameter
einen Benutzernamen und fragt dann
explizit nach einer Shell

e Dieses wird dann in /etc/passwd in der
letzten Spalte eingetragen.

I e Falls man immer eine andere Shell als die



Einrichtung der Shell

* Einstellungen wie Zeilenumbriiche,
Tastenmodus, automatische
Erganzungen,... konnen global von root in
/etc/inputrc oder von jedem Benutzer
selber in ~/ . inputrc eingetragen werden.

e Alle Optionen in diesen Dateien konnen
mitman bash abgeruten werden.



I Wildcards

* Bash unterstiitzt Wildcard dhnlich wie

I command.com unter DOS, allerdings
werden die Wildcards nicht wie bei DOS
von den Anwendungsprogrammen wie
move oder copy, sondern von der Shell
selber ausgewertet, dieses hat
weitreichende Konsequenzen, da Befehle
wie mv *.bak *.sik NICHT funktionieren!



I Die Wildcards im einzelnen
* Der Stern (Asterix) ,,*“ steht fiir jedes
I beliebige Zeichen.
* Das Fragezeichen steht fiir ein beliebiges
Zeichen.

* Falls die Auswertung eines Sonderzeichens
unterdriickt werden soll, muss ein
Backslash ,\“ vorangestellt werden.

* Falls eine ganze Zeichenkette nicht
ausgewertet werden soll, muss man sie in
Hochkommata einschliefSen.



Verschiedene Hochkommata

* Doppelte Anfiihrungszeichen "Test"
verhindern die Auswertung der meisten
Sonderzeichen wie Zeilenumbriiche,
Leerzeichen, Fragezeichen, Asterix
ignoriert.

* Inverse Anfiihrungszeichen "Is” ersetzten
den Befehl durch seine Ausgabe.

* Einfache Anfiihrungszeichen 'Test'
ignorieren alle darin enthaltenen
Anftiihrungszeichen.



Variablen

e Unter der bash konnen Variablen deklariert

werden, sie dienen auch der Steuerung der
bash.

e Variablen konnen mit
export Variable=Wert
deklariert werden, export allein zeigt alle
Variablen an.

e Variablen kOnnen mit $vVariablenname
angesprochen werden, z.B.:
echo $PATH zeigt den aktuellen Suchpfad
fiir Programme an.



I Spezialvariablen

e $! PID des letzten Hintergrundprozesses

e $3$ PID der aktuellen Shell

* $0 Dateiname der gerade ausgefiihrten
Shell, Skripts, des verweisenden Symlinks,...

* $# Anzahl der libergebenen Parameter

e $1,...$9: Parameter 1 bis 9

* shift x verschiebt die Parameterliste um x
Parameter nach links.

* $* oder $@ Alle tibergebenen Parameter

I * $? Riickgabewert des letzten Kommandos



Programmieren mit der bash

* Ein Programmkript ist eine einfache
Textdatei, die erste Zeile sollte so aussehen:
#!/bin/bash damit das Skript mit der
bash und nicht der gerade lautenden Shell
ausgefiihrt wird.

* Kommentare werden durch #
gekennzeichnet, alles bis zum Ende der
Zeile wird dann ignoriert.

* Das Skript wird in einer eigenen Shell
asugetiihrt, gednderte Variablen gelten nur
hier! . Befehl unterdriickt eine Sub-Shell.



I Parametersubstitution

* Die bash bietet auch Mdoglichkeiten,
I Programmabldute zu steuern:

e if, for, while, until, test und weitere Befehle
stehen zur Verfligung.

* Ein Beispiel:
#! /bin/bash
for 1 1n *; do echo $1i; done
if [ $1 = "Test"™ ]; then echo \
"Ja"; else echo "Nein"; f1

e Mehrere Befehle werden hier durch ein
Semikolon getrennt.



I Ein- und Ausgabeumleitung

eine Standardausgabe und eine
Standardfehlerausgabe, diese konnen
umgeleitet werden.

 kommando > datei leitet die Ausgabe um

* kommando < datei liest Befehle aus der
Datei

* kommando 2> leitet die Fehlerausgabe um

* kommando &> leitet alle Ausgaben um

* kommando >> hdngt die Ausgabe an die
Datel an.

I * Es gibt unter Unix eine Standardeingabe,



